Copyright Notice

PAW – Physics Analysis Workstation

CERN Program Library entry Q121

Copyright and any other appropriate legal protection of these computer programs and associated documentation reserved in all countries of the world.

These programs or documentation may not be reproduced by any method without prior written consent of the Director-General of CERN or his delegate.

Permission for the usage of any programs described herein is granted apriori to those scientific institutes associated with the CERN experimental program or with whom CERN has concluded a scientific collaboration agreement.

CERN welcomes comments concerning this program but undertakes no obligation for its maintenance, nor responsibility for its correctness, and accepts no liability whatsoever resulting from the use of this program.

Requests for information should be addressed to:

CERN Program Library Office
CERN-CN Division
CH-1211 Geneva 23
Switzerland
Tel. +41 22 767 4951
Fax. +41 22 767 7155
Bitnet: CERNLIB@CERNVM
DECN: VXCNCRM::CERNLIB (node 22.190)
Internet: CERNLIB@CERNVM.CERN.CH

Trademark notice: All trademarks appearing in this guide are acknowledged as such.

Contact Person: Olivier Couet /CN (couet@cern.ch)
Technical Realization: Michel Goossens /CN (goossens@cern.ch)

Edition - July 1995
Related Manuals

This document can be complemented by the following manuals:

- PAW, Physics Analysis Workstation, The Complete Reference [?]
- COMIS, Compilation and Interpretation System [?]
- HBOOK User Guide — Version 4 [?]
- HIGZ — High level Interface to Graphics and ZEBRA [?]
- HPlot User Guide — Version 5 [?]
- KUIP — Kit for a User Interface Package [?]
- MINUIT — Function Minimization and Error Analysis [?]
- ZEBRA — Data Structure Management System [?]

This document has been produced using L\TeX [?] with the cernman style option, developed at CERN.
All pictures shown are produced with PAW and are included in PostScript [?] format in the manual.
A PostScript file paw++.ps, containing a complete printable version of this manual, can be obtained by anonymous ftp as follows (commands to be typed by the user are underlined):

\begin{verbatim}
ftp asisftp.cern.ch
Trying 128.141.201.136...
Connected to asisftp.cern.ch.
Name (asis01:username): anonymous
331 Guest login ok, send e-mail address as password.
Password: your_mailaddress
ftp> cd cernlib/doc/pd.dir
ftp> get paw++.ps.gz
ftp> get paw++.ps # automatic uncompression
ftp> quit
\end{verbatim}
# Table of Contents

1 PAW++: A guided tour

1.1 Overview ........................................... 2

1.2 The Executive Window ................................ 4
  1.2.1 The Executive Window menu bar .................. 5

1.3 The Main Browser .................................... 7
  1.3.1 The objects in the “object window” ............... 9
  1.3.2 The Main Browser Menu Bar ...................... 22
  1.3.3 Information Windows ............................. 29
  1.3.4 Content Window .................................. 30

1.4 Graphics ........................................... 38
  1.4.1 The Graphics Window ............................ 39
  1.4.2 Ntuple .......................................... 40
  1.4.3 1D-Histogram ................................... 40
  1.4.4 2D-Histogram ................................... 41
  1.4.5 X Axis .......................................... 42
  1.4.6 Y Axis .......................................... 43
  1.4.7 Locate on Histograms ............................ 45
  1.4.8 Locate on Ntuples ................................ 47
  1.4.9 Integrate Histograms ............................. 48

1.5 The Histogram Style Panel .......................... 49
  1.5.1 The Histogram Style Panel Menu Bar ........... 50
  1.5.2 Plot Info ....................................... 50
  1.5.3 Style ........................................... 53
  1.5.4 General Attributes ............................... 54
  1.5.5 Object Attributes ................................. 57
  1.5.6 Geometry ....................................... 61
  1.5.7 Viewing Angles .................................. 62
  1.5.8 Axis Scaling ..................................... 63
  1.5.9 Zones ........................................... 64
  1.5.10 Axis Settings ................................... 64
  1.5.11 Font ............................................ 70
  1.5.12 Plot Options ................................... 72
  1.5.13 Coordinate Systems ............................. 73

1.6 Ntuple Viewer ....................................... 74

1.7 The Cut Editor ...................................... 75
  1.7.1 The Cut Editor Menu Bar ....................... 76
Chapter 1: PAW++: A guided tour

PAW++ is a powerful OSF/Motif based Graphical User Interface to the popular Physics Analysis Workstation PAW. The graphical user interface makes the full and rich command set of PAW available to even the naive user. Simple point and click operations are enough to execute commands that were previously accessible only to expert users.

At present it is available on Unix workstations and VAX/VMS.

PAW++ has, in addition to the conventional command line and macro types of interface, the following dialogue modes:

- **Pull Down menus**: They are useful to understand the command structure of the PAW system.
- **Command panels**: They give a “panel representation” of the commands.
- **Object Browser**: This is in many ways similar to the well-known browsers in the PC/MAC utilities or the visual tools on some workstations.
- **Direct graphics**: One can click in the graphics area and identify automatically which object has been selected. A pop-up menu appears with a list of possible actions on this object. For example, by clicking with the right mouse button on a histogram, one can make directly a gaussian fit, a smoothing etc. Pop-up menus are available by clicking on the **Graphics Window** to automatically produce PostScript, Encapsulated PostScript, \LaTeX\ files or print the picture on your local printer.
- **Histogram Style Panel**: Buttons are available to change histogram attributes, colours, line styles, fonts, and axes representation. 2-D histograms can be rotated interactively. Zooming and rebinning can be performed interactively in real time.
- **Ntuple Viewer**: Just click on the Ntuple column name to histogram the column.

The new system is largely self-explanatory. Only a subset of PAW has been converted to this new user interface, but work is currently in progress to offer many new facilities in future releases.

On all system on which the CERNLIB is installed, it is enough to type `paw++` to enter the system.

PAW++ starts up with three windows on the screen:

- **The “PAW++ Executive Window”**: Which is compose with a menu bar, a **Transcript Pad**, a current working directory indicator and an **Input Pad**.
- **The “PAW++ Graphics 1”**: window displays the graphics output from HIGZ/X11. Objects, e.g. histograms, displayed in the **Graphics Window** can be manipulated by pointing at them, pressing the right mouse button and selecting an operation from the popup menu. Pointing at the edge of the **Graphics Window** (between displayed object and window border) brings up a general popup menu. Up to 4 additional **Graphics Window** can be opened by selecting “Open New Window” from this menu.
- **The “PAW++ Main Browser”**: displays all browsable classes and connected hbook files. Up to 4 additional browsers can be opened via the “View” menu of the **PAW++ Executive Window** or via the “Clone” button on the browsers. For more information on the browsers see the “Help” menus.
1.1 Overview

- The upper left corner is the **PAW++ Executive Window**, with its **Input Pad** at the bottom and the **Transcript Pad** at the top.

- The **PAW++ Browser**, where the various entities (pictures, 1-D and 2-D histograms and Ntuples) are all defined with their own symbol, is shown bottom left. A “pop-up” menu has been activated for the chosen 1-D histogram. Several actions like **Plot**, **Smooth**, **Fit** etc... can be performed via this menu.

- The **Graphics Window** is seen top right. A 1-D view of the data points and two 2-D views (a Surface-plot and a colored contour plot) are shown. On the 1-D view, two 1-D histograms are superimposed. The results of a “smoothing” type of fit to the data points is also drawn. Information about the data and the fit can be found in the inserted window.

- The **Histogram Style Panel** at the lower right allows graphics attributes of the histogram to be controlled.
1.1. Overview

- The upper left corner shows the **Ntuple Viewer**. The left window shows the name of the various variables, characterizing the selected Ntuple. Other windows and press-buttons specify which combinations of the various variables and which events have to be treated (plotted, scanned, ...).
- The lower left contains the **PAW++ Browser**, with this time an Ntuple selected. A double on an Ntuple icon open automatically the **Ntuple Viewer** on the active Ntuple.
- The **Graphics Window** is seen top right and shows a 3-D view of the combination of three variables, whose cuts are specified with the **Cut Editor** (see below).
- Direct graphics interactions with Ntuple data are possible. Just by clicking on a point in the **Graphics Window**, the event description is displayed in the **PAW++ Locate** window.
- The **Cut Editor** panel, shown at the lower right, allows various combinations of cuts to be specified and applied.
1.2 The Executive Window

This window allows to type commands on the keyboard like in the normal PAW system. In fact this window is the kxterm program provide with the KUIP package.

This terminal emulator combines the best features from the (now defunct) Apollo DM pads (like: Input Pad and Transcript Pad, automatic file backup of Transcript Pad, string search in pads, etc.) and the Korn shell emacs-style command line editing and command line recall mechanism.

Commands are typed in the Input Pad behind the application prompt. Via the toggle buttons the Input Pad and/or Transcript Pad can be placed in hold mode. In hold mode one can paste or type a number of commands into the Input Pad and edit them without sending the commands to the application. Releasing the hold button will causes kxterm to submit all lines, upto the line containing the cursor, to the application. To submit the lines below the cursor, just move the cursor down. In this way one can still edit the lines just before they are being submitted to the application.
1.2. The Executive Window

1. In the **Input Pad** one can type, retrieve and edit command line with the help of a Korn shell emacs-style command line editing mode. See in appendix the complete list of the editing keys.

2. The **Transcript Pad** shows the executed commands and command output. When in hold mode the transcript pad does not scroll to make the new text visible. Mouse operations like “Copy Paste” are allowed in the transcript pad. It is also possible to search a character string (see the menu bar description).

3. Every time the current directory is changed, the **Current working directory indicator** is updated. The current working directory can be changed by clicking on a item in the **PATH window** of the **Main Browser** or by clicking on a icon directory in the **Main Browser** itself.

4. Hold buttons.

- Allows manipulation of the **Transcript Pad**.
- Allows character string search, copy/paste in the **Transcript Pad**.
- Allows to invoke other panel.
- Some general settings are available in this menu.
- Online help.

1.2.1 The Executive Window menu bar

In this section, is describe the full functionality of the pull down menu available in the Menu Bar of the **Executive Window**.

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>View</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**File**

- **About Kxterm...** Displays version information about Kxterm.
- **About Application...** Displays version information about the application Kxterm is servicing.
- **Save Transcript** Write the contents of the transcript pad to the current file. If there is no current file a file selection box will appear.
- **Save Transcript As...** Write the contents of the transcript pad to a user-specified file.
- **Print...** Print the contents of the transcript pad (not yet implemented).
- **Kill** Send a SIGINT signal to the application to cause it to core dump. This is useful when the application is hanging or blocked. Use only in emergency situations.
- **Exit** Exit Kxterm and the application. When this option is selected or when **EXIT** is typed in the **Input Pad**, the following panel is displayed:
Chapter 1. PAW++: A guided tour

The exit is performed.  
② The exit procedure is canceled.

Edit

Cut  Remove the selected text. The selected text is written to the Cut and Paste buffer. Using the “Paste” function, it can be written to any X11 program. In the transcript pad “Cut” defaults to the “Copy” function.

Copy  Copy the selected text. The selected text is written to the Cut and Paste buffer. Using the “Paste” function, it can be written to any X11 program.

Paste  Insert text from the Cut and Paste buffer at the cursor location into the Input Pad.

Search... Search for a text string in the transcript pad.

View

Show Input  Show in a window all commands entered via the Input Pad.

Command Panel  Command Panel
Browser  Browser
Style Panel  Style Panel


1.3. The Main Browser

Options

- **Clear Transcript Pad**: Clear all text off of the top of the transcript pad.
- **Echo Command**: Echo executed commands in transcript pad.
- **Timing**: Report command execution time (real and CPU time).
- **Iconify**: Iconify Kxterm and all windows of the application.

Help

- **On Kxterm**: The help you are currently reading.
- **On Edit Keys**: Help on the emacs-style edit key sequences.

1.3 The Main Browser

The KUIP/Motif Browser interface is a general tool to display and manipulate a tree structure of objects which are defined either by KUIP itself (commands, files, macros, etc.) or by the application.

The “Clone” button at the bottom creates a new independent browser window. The “Exit” button destroys the browser window. The **Main Browser** cannot be destroyed (only iconized).

The middle part of the browser is divided into two windows:

1. The left hand “class window” shows the list of all currently connected classes of objects. Some classes, e.g. the command tree and the file system, are predefined. Other classes allow to attach new files using the commands in the “File” menu. Clicking with the left mouse button on one of the items in the class window displays its content in the other window. Pressing the right mouse button inside the class window shows a popup menu of possible operations, e.g. creating a new object in the current directory.

2. The right hand “object window” shows the content of the currently selected class directory. The “View” menu allows the change the way objects are displayed, i.e. to choose the icon size and the amount of information shown for each object. Objects are selected by clicking on them with the left mouse button. Pressing the right mouse button pops up a menu of possible operations depending on the object type.

An item in a popup menu is selected by pointing at the corresponding line and releasing the right mouse button. Double clicking with the left mouse button is equivalent to selecting the first menu item.

Each menu item executes a command sequence where the name of the selected object is filled into the appropriate place. By default the command is executed immediately whenever possible. The commands executed can be seen by selecting “Echo Commands” in the “Options” menu of the **Executive Window**. In case some mandatory parameters are missing a panel is displayed where the remaining arguments have to be filled in. The command is executed then by pressing the “OK” or “Execute” button in that panel. (If it is not the last one in the sequence of commands bound to the menu item the application is blocked until the “OK” or “Cancel” button is pressed.)
The immediate command execution can be inhibited by holding down the CTRL-key BEFORE pressing the right mouse button. Some popup menus also contain different menu item for immediate and delayed execution, e.g. “Execute” and “Execute...” for class “Commands”.

The path of the currently selected directory is always displayed below the menu bar. The directory can be changed by pointing at the tail of the wanted subpath and clicking the left mouse button. Clicking a second time on the same path segment performs the directory change and updates the object window. To go downwards in the directory hierarchy double click on the subdirectory displayed in the object window.

2. Class window.
3. Name of file currently selected in the class window.
1.3. The Main Browser

1.3.1 The objects in the “object window”

This section describes all the PAW++ object available in the Main Browser.

HBOOK files

Double click with the left mouse button on this icon, open the corresponding HBOOK file with the command HISTOGRAM/FILE.

Select a HBOOK files icon with the left mouse button and press the right mouse button to obtain the following menu:

- Open
  - Open the highlighted HBOOK file in read-only mode.
- Open Update Mode
  - Open the highlighted HBOOK file in update mode.

Note that the HBOOK file name is displayed in the menu title.

1D histograms

Double click with the left mouse button on this icon, produce the plot of the corresponding histogram with the command HISTOGRAM/PL0T. The histogram becomes the current histogram for the Histogram Style Panel.

Select a 1D histograms icon with the left mouse button and press the right mouse button to obtain the following menu:
Plot
Plot the corresponding histogram (default action). The histogram becomes the current histogram for the Histogram Style Panel.

Fit...
Perform the command Hist/Fit on the corresponding histogram. The command panel is automatically displayed.

Fit Gauss
Perform a gaussian fit on the corresponding histogram.

Fit Exp
Perform an exponential fit on the corresponding histogram.

Fit Const
Perform a P0 fit on the corresponding histogram.

Fit Linear
Perform a P1 fit on the corresponding histogram.

Smooth
Smooth the corresponding histogram.

Smooth...
Perform the command Smooth on the corresponding histogram. The command panel is automatically invoked.

Copy
Copy corresponding histogram onto another histogram. The command panel is automatically invoked.

Reset
Reset the corresponding histogram.

Delete
Delete the corresponding histogram.

Note that the histogram identifier is displayed in the menu title.

2D histograms

Double click with the left mouse button on this icon, produce the plot of the corresponding histogram with the command HISTOGRAM/PL0T. The histogram becomes the current histogram for the Histogram Style Panel.
Select a **2D histograms** icon with the left mouse button and press the right mouse button to obtain the following menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Plot</strong></td>
<td>Plot the corresponding histogram (default action). The histogram becomes the current histogram for the <strong>Histogram Style Panel</strong>.</td>
</tr>
<tr>
<td><strong>Project X</strong></td>
<td>Generate the X projection, perform the projection and plot the result (commands ProX, Hi/Proj, and Hi/Plot).</td>
</tr>
<tr>
<td><strong>Project Y</strong></td>
<td>Generate the Y projection, perform the projection and plot the result (commands ProY, Hi/Proj, and Hi/Plot).</td>
</tr>
<tr>
<td><strong>Slice X</strong></td>
<td>Generate the X slices, perform the projection and plot the first slice (commands SliX, Hi/Proj, and Hi/Plot).</td>
</tr>
<tr>
<td><strong>Slice Y</strong></td>
<td>Generate the Y slices, perform the projection and plot the first slice (commands SliY, Hi/Proj, and Hi/Plot).</td>
</tr>
<tr>
<td><strong>Band X</strong></td>
<td>Generate the X bands, perform the projection and plot the first band (commands BanX, Hi/Proj, and Hi/Plot).</td>
</tr>
<tr>
<td><strong>Band Y</strong></td>
<td>Generate the Y bands, perform the projection and plot the first band (commands BanY, Hi/Proj, and Hi/Plot).</td>
</tr>
<tr>
<td><strong>Smooth</strong></td>
<td>Smooth the corresponding histogram.</td>
</tr>
<tr>
<td><strong>Smooth...</strong></td>
<td>Perform the command Smooth on the corresponding histogram. The command panel is automatically invoked.</td>
</tr>
</tbody>
</table>
**Copy**

Copy corresponding histogram onto an other histogram. The command panel is automatically invoked.

**Reset**

Reset the corresponding histogram.

**Delete**

Delete the corresponding histogram.

Note that the histogram identifier is displayed in the menu title.

**Ntuples**

Double click with the left mouse button on this icon, open the **Ntuple Viewer** on the corresponding Ntuple.

Select a **Ntuples** icon with the left mouse button and press the right mouse button to obtain the following menu:

- **Open Ntuple Viewer**
  Open Ntuple Viewer on the highlighted Ntuple.

- **Project...**
  Project the highlighted Ntuple. The Command panel `Ntuple/Proj` is automatically invoked.

- **Print**
  Print the highlighted Ntuple (Command `Ntuple/Print`).

Note that the ntuple identifier is displayed in the menu title.

**PAW commands**

Double click with the left mouse button on this icon, execute the corresponding **PAW** command.

Select a **PAW commands** icon with the left mouse button and press the right mouse button to obtain the following menu:
1.3. The Main Browser

Execute

Execute the command with the default parameters. If a mandatory parameter is missing, the command panel is automatically invoked.

Execute...

Display the command panel.

Help

Display the help on the command.

Usage

Display the command usage in the Transcript Pad of the Executive Window.

Manual

Equivalent to HELP.

Set Command

This command becomes the one executed when a directive typed on the keyboard is not an existing PAW command.

Deactivate

The command is deactivated.

Note that the command name is displayed in the menu title.

Deactivated PAW commands

Double click with the left mouse button on this icon, execute the help on corresponding PAW command.

Select a Deactivated PAW commands icon with the left mouse button and press the right mouse button to obtain the following menu:

Help

Display the help on the command.

Activate

The command is activated.

Note that the deactivated command name is displayed in the menu title.
Chapter 1. PAW++: A guided tour

Up

Double click with the left mouse button on this icon, allow to go one level up in the directory tree. This icon is always the first one of the content window.

Select a Up icon with the left mouse button and press the right mouse button to obtain the following menu:

List

Allow to go one level up in the directory tree.

Directory

Double click with the left mouse button on this icon, change the current working directory.

Select a Directory icon with the left mouse button and press the right mouse button to obtain the following menu:

List

Change the current working directory.

PostScript files

Double click with the left mouse button on this icon, invoke the ghostview on the corresponding file.

Select a PostScript files icon with the left mouse button and press the right mouse button to obtain the following menu:

PostScript File paw++2.ps
View
Edit
Print
Delete
1.3. The Main Browser

**View**
Invoke GhostView on the file.

**Edit**
Edit the file.

**Print**
Print the file.

**Delete**
Delete the file.

**Read-Write files**

Double click with the left mouse button on this icon, invoke the editor on the corresponding file.

Select a **Read-Write files** icon with the left mouse button and press the right mouse button to obtain the following menu:

```
Read/Write File Paw
_Edit
_View
_Delete
```

**Edit**
Edit the file.

**View**
Read the file.

**Delete**
Delete the file.

Note that the file name is displayed in the menu title.

**Read-only files**

Double click with the left mouse button on this icon, invoke the editor in view mode on the corresponding file.

Select a **Read-only files** icon with the left mouse button and press the right mouse button to obtain the following menu:

```
Read-only File .profile
_View
_Delete
```

**View**
Read the file.

**Delete**
Delete the file.

Note that the file name is displayed in the menu title.
No-access files

Double click with the left mouse button on this icon, invoke the shell command `chmod` on the corresponding file.

Select a No-access files icon with the left mouse button and press the right mouse button to obtain the following menu:

```
No-access File .rhosts
Chmod
```

Chmod

Try to change the permissions of the file.

Note that the file name is displayed in the menu title.

Executable files

Double click with the left mouse button on this icon, invoke the command `SHELL` on the corresponding file.

Select a Executable files icon with the left mouse button and press the right mouse button to obtain the following menu:

```
Executable File SYSBCKUP
Execute
Execute...
Edit
View
Delete
```

- **Execute**: Invoke the command `SHELL` on the file.
- **Execute...**: Open the command panel `SHELL` with the file name.
- **Edit**: Edit the file.
- **View**: Read the file.
- **Delete**: Delete the file.

Note that the file name is displayed in the menu title.
1.3. The Main Browser

PAW Macros

Double click with the left mouse button on this icon, execute the corresponding macro.

Select a PAW Macros icon with the left mouse button and press the right mouse button to obtain the following menu:

- **Exec**: Execute the macro.
- **Exec...**: Open the command panel EXEC with the macro name. It is useful to give parameters to the macro.
- **Edit**: Edit the macro.
- **View**: Read the macro.
- **Delete**: Delete the macro.

Note that the macro name is displayed in the menu title.

Pictures

Double click with the left mouse button on this icon, plot the corresponding picture.

Select a Pictures icon with the left mouse button and press the right mouse button to obtain the following menu:

- **Plot**: Plot the macro.
- **Do PostScript**: Create PostScript.
- **Create**: Rename the macro.
- **Delete**: Delete the macro.
Chapter 1. PAW++: A guided tour

Plot
Plot the highlighted picture.

Do PostScript
Produce the PostScript file PNAME.ps, where PNAME is the name of the highlighted picture.

Create
Create a new picture. The command panel Picture/Create is automatically invoked.

Rename
Rename the highlighted picture. The command panel Picture/Rename is automatically invoked.

Delete
Rename the highlighted picture.

Chains
Double click with the left mouse button on this icon, allow to go one level deeper in the chain tree.

Select a Chains icon with the left mouse button and press the right mouse button to obtain the following menu:

- List
  List the available chains.

- Show Tree
  Show the tree from the highlighted chain.

- Delete Chain
  Delete the highlighted chain.

Last chain level
Last chain element.

Select a Last chain level icon with the left mouse button and press the right mouse button to obtain the following menu:

- List
  List the available chains.

- Delete Chain Entry
  Delete the highlighted chain element.
1.3. The Main Browser

**ZEBRA Stores**

Double click with the left mouse button on this icon, allow to go inside the corresponding ZEBRA store.

Select a **ZEBRA Stores** icon with the left mouse button and press the right mouse button to obtain the following menu:

- **List**
  - Display divisions of the store
- **Show store DZSTOR**
  - Show parameters of the store (CALL DZSTOR)

**ZEBRA Divisions**

Double click with the left mouse button on this icon, allow to go inside the corresponding ZEBRA division.

Select a **ZEBRA Divisions** icon with the left mouse button and press the right mouse button to obtain the following menu:

- **List**
  - Display banks of the division as icons.
- **Display division**
  - Show layout of banks in divisions graphically.
- **Snap division**
  - Show a snapshot of division parameters. (CALL DZSNAP).
- **Verify division**
  - Verify division (CALL DZVERI).
- **Collect garbage**
  - CALL MZGARB in selected division.
- **Set filter for banks**
  - Allow to display only banks whose hollerith. identifiers match a wild card selection.
ZEBRA Banks

Double click with the left mouse button on this icon, draw the bank tree from the corresponding ZEBRA bank.

Select a ZEBRA Banks icon with the left mouse button and press the right mouse button to obtain the following menu:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display bank tree</td>
<td>Display graphically the structure below the selected bank (see picture banktree.eps).</td>
</tr>
<tr>
<td>Show cont documented</td>
<td>Display the data of the bank with their description if a documentation data base is provided (see CERN Q101).</td>
</tr>
<tr>
<td>DZ Show contents</td>
<td>CALL DZSHOW for selected bank.</td>
</tr>
<tr>
<td>Show system words</td>
<td>List contents of the links and system words.</td>
</tr>
<tr>
<td>Survey bank tree</td>
<td>CALL DZSURV for selected bank.</td>
</tr>
<tr>
<td>Put into vector</td>
<td>Put data contents of the bank into a KUIP vector.</td>
</tr>
<tr>
<td>Show documentation</td>
<td>Display the documentation for the bank (if provided).</td>
</tr>
<tr>
<td>Edit documentation</td>
<td>Edit a bank descriptor, if no available yet provide a template.</td>
</tr>
<tr>
<td>Modify data words</td>
<td>Self explaining.</td>
</tr>
<tr>
<td>Drop bank (tree)</td>
<td>Self explaining.</td>
</tr>
</tbody>
</table>
1.3. The Main Browser

**RZ Files**

Double click with the left mouse button on this icon, allow to go inside the corresponding ZEBRA/RZ file.

Select a RZ Files icon with the left mouse button and press the right mouse button to obtain the following menu:

- **Close RZ file**
  - Self explaining.
- **List**
  - Display keys.
- **List directory**
  - CALL RZLDIR.
- **Show key definition**
  - Self explaining.
- **Set filter on keys**
  - Allow to display only entries whose key words match a wildcard selection.
- **Show status**
  - CALL RZSTAT.

**RZ Directories**

Double click with the left mouse button on this icon, allow to go inside the corresponding ZEBRA/RZ directory.

Select a RZ Directories icon with the left mouse button and press the right mouse button to obtain the following menu:

- **List**
  - List the highlighted RZ directory.
- **List directory (RZLDIR)**
  - Perform RZLDIR on the highlighted RZ directory.
- **Show key definition**
  - Display the key definition.
- **Set filter on keys**
  - Defines a filter on the keys.
RZ Keys

Double click with the left mouse button on this icon, allow to read into memory the corresponding ZEBRA/RZ key.

Select a RZ Keys icon with the left mouse button and press the right mouse button to obtain the following menu:

<table>
<thead>
<tr>
<th>Keys 10_0 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read key into memory</td>
</tr>
<tr>
<td>Show key definition</td>
</tr>
<tr>
<td>Show key words</td>
</tr>
<tr>
<td>Set filter on keys</td>
</tr>
</tbody>
</table>

1.3.2 The Main Browser Menu Bar

In this section, is describe the full functionality of the pull down menu available in the Menu Bar of the Main Browser.

File

| Open Hbook file | Display the Open Arguments panel (see after). |
| Close Hbook file | Display the Close Arguments panel (see after). |
1.3. The Main Browser

---

1. Toggle buttons to choose the opening mode.
2. Filter apply on the file list.

---

Open in Read Only Mode
Open in Update Mode
Create New File

Filter

/user/couet/paw++/*.hbook

Directories

/user/couet/paw++/
/user/couet/paw++/..
/user/couet/paw++/3dfield
/user/couet/paw++/cmotif
/user/couet/paw++/fmotif
/user/couet/paw++/pict
/user/couet/paw++/uimx

Files

brun.hbook
cern.hbook
d0bb2.hbook
demo.hbook
grades.hbook
hrztest.hbook
iostat.hbook

Open File

/user/couet/paw++/

---

OK
Filter
Cancel
Help
3 Possible logical units. Only the free units are displayed. The next free unit is highlighted. Any other unit is invalid.

4 Possible record length. A record length of 0 means that the system will compute the correct one automatically.

1 The file is open and this panel is closed.
2 File name of the opened file.
3 Apply the filter defined in 2.
4 List of the subdirectories available. Double click on a directory name change the current directory.
5 Cancel the current opened panel and close it.
6 List of the file in the current directory matching the filter.
7 Help

Note that a double click with the left mouse button on a HBOOK file icon in the object window of the Main Browser open also the HBOOK file. This panel is useful to specify a filter different from the default filter *.hbook used in the object window.
1. List of the currently connected hbook files.
2. A simple click with the left mouse button a file name in the connected files list, highlight the file-name and put it in the Close file field ③.
3. Name of the file to be closed. This field can be filled directly by tipyng on the keyboard, or by a simple click with the left mouse button in the Connected Files list ①.
1. When a file is selected, clicking on this button or typing <CR> allows to perform the action (close the file) and close the panel.
2. Close the selected file and leave the panel opened.
3. Cancel the current operation and close the panel.

View

This pull-down menu allows to define the “viewing” for the objects in the “object window” of the Main Browser.

- **Icons**: The objects are represented with big icons (default).
- **Small Icons**: The objects are represented with small icons.
- **No Icons**: Only the object identifier and type are displayed.
- **Titles**: Small icons, objects identifiers and titles are displayed.
- **Select All**: All the objects are selected.
- **Filter...**: Apply a filter on object names.

Icons: icons and the object identifiers are displayed.
1.3. The Main Browser

Small Icons: small icons and the object identifiers are displayed.

No Icons: object identifiers and titles are displayed.
Chapter 1. **PAW++: A guided tour**

**Options**

- **Raise Window**
  - Raise a given window.
- **Command Argument Panel...**
  - Get help on a given command.

**Commands**

This menu allows to access the tree of the PAW commands. Only the top levels are described in this section. Note the tree of the PAW commands can also be accessed via the item “Commands” in the “PATH Window” of the Main Browser.

Titles: small icons and the object identifiers and titles are displayed.
1.3. The Main Browser

Kuip  Command Processor commands.
Macro  Macro Processor commands.
Vector  Vector Processor commands.
Histogram  Manipulation of histograms, Ntuples.
Function  Operations with Functions. Creation and plotting.
Ntuple  Ntuple creation and related operations.
Graphics  Interface to the graphics packages HPlot and HIGZ.
Picture  Creation and manipulation of HIGZ pictures.
Fortran  Interface to MINUIT, COMIS, SIGMA and FORTRAN Input/Output.
Network  To access files on remote computers.
Dzdoc  Access Dzdoc

Help

1.3.3 Information Windows

Top

<table>
<thead>
<tr>
<th>Path:</th>
<th>//LUN1</th>
</tr>
</thead>
</table>

On the top of the Main Browser is displayed the current directory PATH and the content of the current directory i.e. the number of objects of each type.
On the bottom of the **Main Browser** is displayed the name of the current file (HBOOK files for example) in which the objects are stored. If the objects are not stored in a file (like the commands), the file name is just blank. Below the file name, the full name of the currently selected object is displayed.

### 1.3.4 Content Window

In this section are describe the different menu available in the “Content Window”.

#### Commands

- **List**
  - List the content of the current menu.
- **Set Default**
  - Set the root for searching commands to `/`.
- **Help**
  - Display some help.
Files

List the content of the current working directory (OS).

Chdir to ... Change directory.

Edit Edit a file.

Help Display some help.
Macro

List all the macros in the current working directory.

Edit

Edit a macro.

Help

Display some help.
Zebra

List
Open bank doc Rzfile
Add doc directory
Put doc into Rzfile
Display bank tree
Help

List the ZEBRA file connected.
Open bank doc Rzfile.
Add doc directory.
Put doc into Rzfile.
Display bank tree.
Display some help.
Hbook

List all the HBOOK files in the current working directory.

Help

Display some help.
1.3. *The Main Browser*

### Chains

![Paw++ Main Browser](image)

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Options</th>
<th>Commands</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Path:** /MB1

**Chain:** 2

**Commands**

- **Files**
- **Macro**
- **Zebra**
- **Hbook**
- **Chains**
- **PAWC**
- **LUN1**

**File:** MB05

**Menu Options:**

- **List**
- **Delete All Chains**
- **Help**

**Meanings:**

- **List**
  - List the chains currently in memory.
- **Delete All Chains**
  - Delete all the chains from memory.
- **Help**
  - Display some help.
This panel allows to navigate in the chain tree. Just clicking on a chain name change the level from which the chain will be traversed.
### PAWC

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List</td>
<td>List all the HBOOK objects in memory.</td>
</tr>
<tr>
<td>Create 1d</td>
<td>Create a 1d histogram.</td>
</tr>
<tr>
<td>Create Profile</td>
<td>Create a Profile histogram.</td>
</tr>
<tr>
<td>Create Var-Bin</td>
<td>Create a variable bin size histogram.</td>
</tr>
<tr>
<td>Create 2d</td>
<td>Create a 2d histogram.</td>
</tr>
<tr>
<td>Create N-tuple</td>
<td>Create a row wise Ntuple histogram.</td>
</tr>
<tr>
<td>Clear</td>
<td>Delete histograms from memory.</td>
</tr>
<tr>
<td>Help</td>
<td>Provide some help.</td>
</tr>
</tbody>
</table>
Hbook Files (\LUNn)

List all the HBOOK objects in this file.

Copy to \PAWC
Copy the highlighted HBOOK object in memory.

Add to \PAWC
Add the highlighted HBOOK object in memory.

Write from \PAWC...
Save the highlighted HBOOK object on disk.

Create N-tuple
Create a row wise Ntuple histogram.

Clear
Delete histograms from disk.

Close
Close the selected hbook file

Help
Provide some help.

1.4 Graphics

PAW++ allows direct graphics manipulation of the objects like Histograms or Ntuples. To perform actions on object from the Graphics Window, it is enough to move the mouse cursor on the Graphics Window and to click with the right mouse button on the object. A pull down menu will be displayed according to the object picked. In this section are described the different menus available in the Graphics Window.
1.4.1 The Graphics Window

When no object is picked in the Graphics Window for instance when the background of the window is picked the following menu is displayed.
Chapter 1. PAW++: A guided tour

### 1.4.2 Ntuple

When a Ntuple is picked in Graphics Window with the right mouse button, the following menu is displayed:

<table>
<thead>
<tr>
<th>Ntuple 30</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Ntuple Viewer</td>
</tr>
<tr>
<td>Project...</td>
</tr>
<tr>
<td>Print</td>
</tr>
</tbody>
</table>

### 1.4.3 1D-Histogram

When a 1D-Histogram is picked in Graphics Window with the right mouse button, the following menu is displayed:

<table>
<thead>
<tr>
<th>Graphics Window 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot</td>
</tr>
<tr>
<td>Style Panel...</td>
</tr>
<tr>
<td>Double Buffer On</td>
</tr>
<tr>
<td>Double Buffer Off</td>
</tr>
<tr>
<td>Do PostScript...</td>
</tr>
<tr>
<td>Do Encapsulated PostScript...</td>
</tr>
<tr>
<td>Do LaTeX...</td>
</tr>
<tr>
<td>Print</td>
</tr>
<tr>
<td>Open New Window</td>
</tr>
<tr>
<td>Close Window</td>
</tr>
<tr>
<td>Activate Window</td>
</tr>
<tr>
<td>Deactivate Window</td>
</tr>
</tbody>
</table>

- **Plot**
  - Plot the current picture.
- **Style Panel...**
  - Invoke the Histogram Style Panel.
- **Double Buffer On**
  - Set the double buffer on.
- **Double Buffer Off**
  - Set the double buffer off.
- **Do PostScript...**
  - Generate the Postscript file `paw.ps`.
- **Do Encapsulated PostScript...**
  - Generate the Encapsulated Postscript file `paw.eps`.
- **Do LaTeX...**
  - Generate the LaTeX file `paw.tex`.
- **Print**
  - Print the current picture.
- **Open New Window**
  - Open a new window.
- **Close Window**
  - Close the current window.
- **Activate Window**
  - Activate the current window.
- **Deactivate Window**
  - Deactivate the current window.
1.4. Graphics

1.4.4 2D-Histogram

When a 2D-Histogram is picked in Graphics Window with the right mouse button, the following menu is displayed:

- **Fit Command**... Invoke the fit command.
- **Fitting panel**... Invoke the fit panel.
- **Fit Gauss** Perform a gaussian fit.
- **Fit Exp** Perform an exponential fit.
- **Fit Const** Fit with a constant.
- **Fit Linear** Perform a linear fit.
- **Smooth** Smooth.
- **Smooth**... Invoke the smooth command.
- **Line** Draw the histogram with a line.
- **Curve** Draw the histogram with a curve.
- **Bar Chart** Draw the histogram as a bar chart.
- **Marker** Draw the histogram with markers.
- **Stars** Draw the histogram with stars.
- **Error Bars** Draw the histogram with error bars.
- **Error Bars (lines)** Draw the histogram with error bars ended with tick marks.
- **Error Rectangles** Draw the histogram with error rectangles.
- **Error: Filled Area** Draw the histogram as a filled area.
- **Error: Smoothed Area** Draw the histogram as a smoothed and filled area.
- **Lego** Draw the histogram as a lego plot.
- **Filled Lego** Draw the histogram as a filled lego plot.
- **Default** Default histogram drawing.
1.4.5 X Axis

When a X-Axis is picked in Graphics Window with the right mouse button, the following menu is displayed:
Logarithmic
Log scale on.

Linear
Linear scale on.

Sort in alphabetical order
Reorder the bins.

Sort in reverse alphabetical order
Reorder the bins.

Sort by increasing channel contents
Reorder the bins.

Sort by decreasing channel contents
Reorder the bins.

Number of divisions...
Define number of X divisions.

Tick marks length...
Tick marks size.

Values Distance...
Labels distance.

Character Font...
Labels font.

Axis Color...
Axis color.

1.4.6 Y Axis

When a Y-Axis is picked in Graphics Window with the right mouse button, the following menu is displayed:
### Y Axis 515

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Logarithmic</strong></td>
<td>Log scale on.</td>
</tr>
<tr>
<td><strong>Linear</strong></td>
<td>Linear scale on.</td>
</tr>
<tr>
<td><strong>Sort in alphabetical order</strong></td>
<td>Reorder the bins.</td>
</tr>
<tr>
<td><strong>Sort in reverse alphabetical order</strong></td>
<td>Reorder the bins.</td>
</tr>
<tr>
<td><strong>Sort by increasing channel contents</strong></td>
<td>Reorder the bins.</td>
</tr>
<tr>
<td><strong>Sort by decreasing channel contents</strong></td>
<td>Reorder the bins.</td>
</tr>
<tr>
<td><strong>Number of divisions...</strong></td>
<td>Define number of Y divisions.</td>
</tr>
<tr>
<td><strong>Tick marks length...</strong></td>
<td>Tick marks size.</td>
</tr>
<tr>
<td><strong>Values Distance...</strong></td>
<td>Labels distance.</td>
</tr>
<tr>
<td><strong>Character Font...</strong></td>
<td>Labels font.</td>
</tr>
<tr>
<td><strong>Axis Color...</strong></td>
<td>Axis color.</td>
</tr>
</tbody>
</table>
1.4.7 Locate on Histograms

To retrieve interactively on the Graphics Window an histogram identifier a bin number, a \((X, Y)\) position etc..., place the mouse cursor on the graphics area and click with the left mouse button on the interesting region. The information about the picked histogram will appear in the window called **PAW++ Locate**.

- **1D Histogram** (with LOG scale).
- **2D Histogram**.
- **PAW++ Locate** window.
- **To release the Output window.**
(1) Info the 1D Histogram.
(2) Info the 2D Histogram.
1.4.8 Locate on Ntuples

Just by clicking with the left mouse button on a Ntuple drawing, one can get the event description in the PAW++ Locate window. If the mouse cursor is moved on the Ntuple drawing with the left mouse button pressed, the event description will change in real time in PAW++ Locate.

1. Ntuple drawing.
2. PAW++ Locate window.
3. To release the Output window.
4. Event description.
1.4.9 Integrate Histograms

To integrate interactively an histogram, place the mouse cursor on the bin from which the integration will start, and drag the cursor with the left mouse button pressed to the last bin. The result will appears in real time in a separated window called PAW++ Locate.

1. Integrated area.
2. Output window. It is possible to copy (via the mouse) the text inside this window.
3. To release the Output window.

1 Histogram identifier.
1.5 The Histogram Style Panel

The Histogram Style Panel allows to manipulate and present histograms. It works on one histogram only: the “Current histogram”. To set the current histogram it is enough to plot it for the Main Browser, via a double click on the icon.

1. Plot the current histogram.
2. Add informations on the plots.
3. Define the graphical option used to plot the current histogram.
4. Reset the default attributes.
5. Define the coordinate system used to draw lego and surface plots.
6. Define attributes used to draw the current histogram.
7. Close the Histogram Style Panel.
1.5.1 The Histogram Style Panel Menu Bar

In this section, is describe the full functionality of the pull down menu available in the Menu Bar of the Histogram Style Panel.

### File

- **Open Style**
  - Allows to choose and execute a “Style Macro”. This “Style Macro” becomes the “current style”. This field in the Histogram Style Panel is updated with the “current style” name. The “Style Macro” have by default the extension .sty.

- **Save Style**
  - Save the “current style”. When a style is saved, all the current attribute values are saved in the “Style Macro”.

- **Save Style As...**
  - Save the “current style” with a new name.

- **Close**

### Options

- **Automatic Refresh**
  - By default the “Automatic Refresh” is on: each time the “current picture” is changed, the graphics window is updated. When this mode is off, the user has to click on one of the [Apply] button available.

- **Overlay**
  - Each time a new histogram, vector, or ntuple drawing is produced, a clear window is performed. To superimpose all the drawing on the same image, it is enough to put this option on. This option is the equivalent of the option S in the command HIST0/PL0T.

1.5.2 Plot Info

This set of toggle buttons allow to add some usefull information on the curren plot. If the Automatic refresh mode is on, the plot is automatically refresh.
1.5. The Histogram Style Panel

Statistics... Allow to draw (or not) the statistics on the plot (P A W command **OPTION STAT**). When the toggle button is set on, a panel is displayed in order to specify with parameters will be visible.

Fits... Allow to draw (or not) the fit parameters on the plot (P A W command **OPTION FIT**). When the toggle button is set on, a panel is displayed in order to specify with parameters will be visible.

File Name... Allow to draw (or not) the file name on the plot (P A W command **OPTION FILE**). When the toggle button is set on, a panel is displayed in order to specify the file name position.

Date... Allow to draw (or not) the date on the plot (P A W command **OPTION DATE**). When the toggle button is set on, a panel is displayed in order to specify the date position.

Statistics ...

This panel is the equivalent of the P A W command **SET STAT**. It allows to specify which statistics informations are displayed on the plot.

- **Histogram ID**
  - The histogram identifier is displayed.
- **Entries**
  - The number of entries is displayed.
- **Mean value**
  - The mean value is displayed.
- **R.M.S.**
  - The R.M.S. is displayed.
- **Underflows**
  - The underflows are displayed.
- **Overflows**
  - The overflows are displayed.
- **All channels**
  - The content of the total number of channel is displayed.

Fits ...

This panel is the equivalent of the P A W command **SET FIT**. It allows to specify which fit parameters are displayed on the plot.
Chapter 1. PAW++: A guided tour

Chi Square  The chi square is displayed.
Errors     The errors are displayed.
Parameters The fit parameters are displayed.

File Name ...

This panel is the equivalent of the PAW command SET FILE. It allows to specify the file name position on the plot.

Top Left   The file name is drawn on the top left of the plot (default).
Top Right  The file name is drawn on the top right of the plot
Bottom Left The file name is drawn on the bottom left of the plot
Bottom Right The file name is drawn on the bottom left of the plot
1.5. The Histogram Style Panel

Date ...

This panel is the equivalent of the PAW command SET DATE. It allows to specify the date position on the plot.

- **Top Left**: The date is drawn on the top left of the plot.
- **Top Right**: The name is drawn on the top right of the plot (default).
- **Bottom Left**: The date is drawn on the bottom left of the plot.
- **Bottom Right**: The date is drawn on the bottom left of the plot.

1.5.3 Style

**Object Attributes**: Invoke the “Object Attributes” panel.
**Viewing Angles**: Invoke the “Viewing Angles” panel.
**Axis Scaling**: Invoke the “Axis Scaling” panel.
**General Attributes**: Invoke the “General Attributes” panel.
**Geometry**: Invoke the “Geometry” panel.
**Axis Settings**: Invoke the “Axis Settings” panel.
**Zones**: Invoke the “Zones” panel.
**Font**: Invoke the “Font” panel.
1.5.4 General Attributes

The “General Attributes” panel allow to define attributes like marker type, marker size, line type or color definition for the low level graphics primitives like the lines, the markers the boxes etc...

1. This menu choice allow to define the current marker type used.

2. This scale allow to change the marker scale factor.

3. This menu choice allow to define the current line style used.

4. This push button open the “Define Color” panel (see after).

1 By default the “automatic refresh” is on and as soon as an attribute is changed, the current picture is updated with the new attribute value. But when the “automatic refresh” is off, this button becomes active and should pressed in order to update the current picture with the new attribute value.

2 This push button allow to reset the default value of all the attributes manageable in this panel.

3 Close this panel.
1.5. The Histogram Style Panel

Define Color

This panel is invoked when the button number ➃ is pressed in the “General Attributes” panel. This panel allows to define a color in RGB or HLS modes.

① Percentage of Blue in the color define by the Current Color index ➉.
Chapter 1. PAW++: A guided tour

2 Percentage of Blue in the color defined by the **Current Color index**.
3 Percentage of Blue in the color defined by the **Current Color index**.
4 Light.
5 Saturation
6 Hue.
7 Hue scale.
8 Maximum number of colors.
9 Colors index to be changed.

1 Apply the changes.
2 Define the color.
3 Reset the color.
4 Reset.
5 Close the panel
1.5.5 Object Attributes

The “Object Attributes” panel allows to define the graphics attributes of the HPLOT objects managed by PAWs such as: Histograms, Axis etc... On the left part of this panel the type of object can be defined via a list of toggle buttons. For example here “Histogram” is selected: all the attributes definable in the panel will be apply on the histograms (histogram color, histogram line width etc...).

The zones affected by the buttons ① to ⑤, are shown on the next figure.
Apply the changes if the “automatic refresh” is not on.
2 Change the title of the selected object.
3 Reset all the attributes.
4 Close this panel
5 Change the line width of the selected object.
6 Reset the attributes of the selected object.
7 Invoke the “Object Colors” panel.
8 Invoke the “Object Hatch Style” panel.
Object Hatch Style

① Define the distance between two hatches.
② Define the angle of the first set of hatches.
③ Define the angle of the second set of hatches.

① Apply
② Define the hatches type by number.
60

Chapter 1. PAW++: A guided tour

3 Reset the default.
4 Close this panel.

Object Colors

1 Surface color.
2 Contour color.
3 Statistic box shadow color.
4 Zone box shadow color.

1 Apply
2 Reset the color index.
3 Close the panel.
4 Define the color index.
1.5.6 Geometry
1. Apply.
2. Define the attribute value by number.
3. Reset the default value.
4. Name of the current attribute changed.
5. Close the panel.
6. Vary continuously the attribute selected.
7. Select the attribute to be modified.

1.5.7 Viewing Angles

Apply.
Reset the both angles to 30 degrees.
Close the panel.

Rotating cube use to define the angles.
Allow to specify the theta value.
Allow to specify the phi value.
1.5.8 Axis Scaling

1. Change the Y first bin value.
2. Change the Y second bin value.
3. Change the X first bin value.
4. Change the X first bin value.
5. Lock the range between the first and the last X bins.
6. Apply.
7. Set the minimum Z value.
8. Set the maximum Z value.
9. Lock the range between the first and the last Y bins.
10. Reset the default values.
11. Rebin the 1D histograms.
12. Close the panel.
1.5.9 Zones

This panel is a direct interface to the Zone command.

1. Active zone.
2. Not active zone.

1. Reset to one zone.
2. Close the panel.

1.5.10 Axis Settings

This panel allows to define the labelling, number of divisions and axis properties (like LOG scale), of the X, Y and Z axis. This is a direct interface to the commands `SET NDVX, NDVY` etc...
Activate or desactivate the tick marks optimization.
Activate or desactivate the Log scale.
Activate or desactivate the additional tick marks on the top and right of the plot.
Activate or desactivate the grid drawing.

Apply.
Reset the defaults.
Close the panel
Define the tertiary divisions.
Define the secondary divisions.
Define the primary divisions.
Display the “Labels” panel.
Display the “Orientation” panel.
Select on which axis the whole panel will act.

Axis Labels

The panel defines the type of label used.
1.5. The Histogram Style Panel

The diagram shows the "Axis Labels" panel with options for numeric and alphanumeric labels. The numeric option is selected, and the alphanumeric labels section contains entries such as "JAN FEV MAR APR" and "AAA BBB CCC". The "Close" button is located at the bottom.
1. Close the panel.
2. Activate one of the alphanumeric list.
3. Define an alphanumerique list.
4. The labelling is numeric.
1.5. The Histogram Style Panel

Label Orientation

Defines the labels orientation.
1. Reset the default orientation.
2. Close the panel.
3. Define the X axis labels orientation.
4. Define the Y axis labels orientation.

1.5.11 Font

Font selector.

1. Apply.
2. Reset the default font.
3. Close the panel.
4. Select the font for the various type of text.
1.5. The Histogram Style Panel

The font settings panel allows to define the font and the precision of a given type of text.

The font may be chosen among the standard X11/PostScript fonts.
1.5.12 Plot Options

The possible plotting option for 1D histograms available in the Histogram Style Panel are the following:

<table>
<thead>
<tr>
<th>Default</th>
<th>Normal histogram drawing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Draw the histogram with line.</td>
</tr>
<tr>
<td>Smooth Curve</td>
<td>Draw the histogram as a smooth curve.</td>
</tr>
<tr>
<td>Bar Chart</td>
<td>Draw the histogram as a bar chart.</td>
</tr>
<tr>
<td>Star</td>
<td>Draw the histogram with stars.</td>
</tr>
<tr>
<td>Error Bars</td>
<td>Draw the histogram with error bars.</td>
</tr>
<tr>
<td>Error Bars (lines)</td>
<td>Draw the histogram with error bars ended with tick marks.</td>
</tr>
<tr>
<td>Error Rectangles</td>
<td>Draw the histogram with error rectangles.</td>
</tr>
<tr>
<td>Error: Filled Area</td>
<td>Draw the histogram as a filled area.</td>
</tr>
<tr>
<td>Error: Smoothed Area</td>
<td>Draw the histogram as a smoothed and filled area.</td>
</tr>
<tr>
<td>Hidden Lines Surface</td>
<td>Draw the histogram as a surface.</td>
</tr>
<tr>
<td>Color Level Surface (1)</td>
<td>Draw the histogram as a surface.</td>
</tr>
<tr>
<td>Color Level Surface (2)</td>
<td>Draw the histogram as a surface.</td>
</tr>
<tr>
<td>Hidden Lines Lego</td>
<td>Draw the histogram as a lego.</td>
</tr>
<tr>
<td>Filled Lego</td>
<td>Draw the histogram as a lego.</td>
</tr>
<tr>
<td>Color Level Lego</td>
<td>Draw the histogram as a lego.</td>
</tr>
</tbody>
</table>
The possible plotting option for 2D histograms available in the **Histogram Style Panel** are the following:

<table>
<thead>
<tr>
<th>Default</th>
<th>Scatter plot.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boxes</td>
<td>Boxes plot.</td>
</tr>
<tr>
<td>Color</td>
<td>Color plot.</td>
</tr>
<tr>
<td>Hidden Lines Surface</td>
<td>Surface plot.</td>
</tr>
<tr>
<td>Color Level Surface (1)</td>
<td>Surface plot.</td>
</tr>
<tr>
<td>Color Level Surface (2)</td>
<td>Surface plot.</td>
</tr>
<tr>
<td>Surface and Contour</td>
<td>Surface plot.</td>
</tr>
<tr>
<td>Gouraud Shaded Surface</td>
<td>Surface plot.</td>
</tr>
<tr>
<td>Hidden Lines Lego</td>
<td>Lego plot.</td>
</tr>
<tr>
<td>Filled Lego</td>
<td>Lego plot.</td>
</tr>
<tr>
<td>Color Level Lego</td>
<td>Lego plot.</td>
</tr>
<tr>
<td>Contour Plot</td>
<td>Line contour plot.</td>
</tr>
<tr>
<td>Filled Contour Plot</td>
<td>Filled contour plot.</td>
</tr>
<tr>
<td>Text</td>
<td>Text plot.</td>
</tr>
</tbody>
</table>

### 1.5.13 Coordinate Systems

Various coordinate systems can be chosen for surface and lego plots.

<table>
<thead>
<tr>
<th>Cartesian</th>
<th>All lego and surfaces will be in cartesian coordinates.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polar</td>
<td>All lego and surfaces will be in polar coordinates.</td>
</tr>
<tr>
<td>Cylindrical</td>
<td>All lego and surfaces will be in cylindrical coordinates.</td>
</tr>
<tr>
<td>Spherical</td>
<td>All lego and surfaces will be in spherical coordinates.</td>
</tr>
<tr>
<td>Pseudo Rapidity</td>
<td>All lego and surfaces will be in pseudo rapidity coordinates.</td>
</tr>
</tbody>
</table>
1.6 Ntuple Viewer

1. Field showing the current directory and the name of the Ntuple.
2. The names of the variables defined for the Ntuple. If you double click on one of the variable names a histogram showing the values of the variable will be plotted.
3. The $X$, $Y$ and $Z$ fields allow you to define which variables will be used by the Plot and Scan buttons. These fields can be filled in two ways: firstly by typing the name or an expression of a variable; secondly by double-clicking in one of the $X$, $Y$ or $Z$ fields. In the latter case the field pointed at is
filled with the variable highlighted in the list of variables.

④ Defines the first row used in the Ntuple when the [Plot] or [Project] buttons are pressed.

⑤ Defines the number of rows used (starting from First Row) when the [Plot] or [Project] buttons are pressed.

⑥ Defines the histogram identifier used when the [Plot] or [Project] buttons are pressed.

⑦ Fields showing the number of rows and columns in the Ntuple.

⑧ A toggle button allowing you to enable/disable the cuts defined with the Cut Editor.

⑨ A toggle button, which, when pressed will produce the next plot on top of an already existing one, i.e. without clearing the graphics window.

⑩ If pressed, 2D plots are drawn with boxes.

① Close the Ntuple Viewer.

② Invoke the Cut Editor.

③ When it is pressed, the Ntuple variables types and ranges are also listed.

④ Produce a plot using all the indications specified on the Ntuple Viewer panel.

⑤ Invoke the Ntuple Scanner.

⑥ Perform the NTUPLE/LOOP command.

⑦ If pressed, the 2D plots produce profile histograms.

⑧ Project the selected variables in the histogram specify in ⑥.

⑨ Help on the Ntuple Viewer.

1.7 The Cut Editor

① Invoke the File menu.

② Invoke the Edit menu.
Invoke the Options menu.
Current cut expression applied.

Apply the cut.
Apply the cut and replot the graph.
Close the cut editor.
Cut definition panel. The current cut is highlighted with a red line. A cut can be activate or deactivated with the toggle button on the left. It can be negate with the push button on the right of the cut number. A “!” appears on this button when the cut is negated. The cut definition is done by filling the two editable fields and with the menu choices.

1.7.1 The Cut Editor Menu Bar

In this section, is describe the full functionality of the pull down menu available in the Menu Bar of the Cut Editor.

File
Read/Write cuts on disk.

Open
Open a cut file.
Save Cuts
Save the current cuts on disk.
Save Cuts As ...
Save the current cuts on disk in a specific file.
Close
Close the panel.
1.7. The Cut Editor

Edit

Edit the cuts.

- **Add Cut Before** - Add a cut line before the current cut line.
- **Add Cut After** - Add a cut line after the current cut line.
- **Add ( Before** - Add a ( line before the current cut line.
- **Add ( After** - Add a ( line after the current cut line.
- **Add ) Before** - Add a ) line before the current cut line.
- **Add ) After** - Add a ) line after the current cut line.
- **Delete item** - Delete the current cut line.
- **Delete All items** - Delete all the cut lines.

Options

- **Show Tree...**
- **Dynamic Mode...** - The current cut can be change dynamically.
- **Indentation...** - Indente the cut definitions.
- **Activate all cuts** - Activate all cuts
- **Deactivate All cuts** - Deactivate all cuts.
1.7.2 Ntuple Scanner

The PANEL Interface allows to define command sequences which are executed when the corresponding button is pressed (like STYLE GP in PAW/X11). The command sequence

```plaintext
PANEL 0
PANEL 4.06 'some string'
PANEL 0 D 'This is my first panel' 500x300+500+600
```

creates a panel with 4 rows and 6 columns of buttons. The text ‘some string’ should be long enough to fit the longest command Sequence which should be put onto one of the buttons. The ‘PANEL 0 D’ command defines the title and the window size and coordinates in the form WxH+X+Y.

The panels can be edited interactively:
- Clicking with the right mouse button on an empty panel button the user will be asked to give a definition to this button.
- Clicking with the left mouse button on a panel button removes its definition.

The PANEL commands needed to recreate a panel can be saved into a macro file by pressing the “Save Panel” button. Panels can be reloaded either by executing the command ‘PANEL 0 D’ or by pressing the

1.8 KUIP/Motif Panel Interface

The PANEL Interface allows to define command sequences which are executed when the corresponding button is pressed (like STYLE GP in PAW/X11). The command sequence

```plaintext
PANEL 0
PANEL 4.06 'some string'
PANEL 0 D 'This is my first panel' 500x300+500+600
```

creates a panel with 4 rows and 6 columns of buttons. The text ‘some string’ should be long enough to fit the longest command Sequence which should be put onto one of the buttons. The ‘PANEL 0 D’ command defines the title and the window size and coordinates in the form WxH+X+Y.

The panels can be edited interactively:
- Clicking with the right mouse button on an empty panel button the user will be asked to give a definition to this button.
- Clicking with the left mouse button on a panel button removes its definition.

The PANEL commands needed to recreate a panel can be saved into a macro file by pressing the “Save Panel” button. Panels can be reloaded either by executing the command ‘PANEL 0 D’ or by pressing the
“Command Panel” button in the “View” menu of the Executive Window and entering the corresponding file name.
Appendix A: X Window resources

A.1 X resources for PAW++

This is a list of the X resources available to PAW++. Resources control the appearance and behavior of an application. Users can specify their own values for these resources in the standard X11/Motif way (via their own .Xdefaults file or the system wide /usr/lib/X11/app-defaults/Paw++ file). Any default values specified by PAW++ are given behind the resource name.

  Paw+++background:

Specify the background color for all windows.

  Paw+++foreground:

Specify the foreground color for all windows.

  Paw+++kxtermGeometry: 550x550+5+10

Geometry of Kxterm, the KUIP terminal emulator (PAW++ Executive Window).

  Paw+++kuipGraphics_shell.geometry: 550x550+585+10

Geometry of the Graphics Window(s) (if any).

  Paw+++kuipBrowser_shell.geometry: 495x511+161+481

Geometry of the Browser(s).

  Paw+++histoStyle_shell.geometry: 599x360+668+631

Geometry of the Style Panel.

  Paw+++ntupleBrowser_shell.geometry:

Geometry of the Ntuple Viewer.

  Paw+++XmText*fontList: *-prestige-medium-r-normal-*120-*
  Paw+++XmTextField*fontList: *-prestige-medium-r-normal-*120-*

Font used by all text areas.

  Paw+++kxtermFont: *-prestige-medium-r-normal-*120-*

Font used by Kxterm (PAW++ Executive Window)

  Paw+++dirlist*fontList: *-courier-bold-r-normal*-120-*
A.1. X resources for PAW++

Font used for the icon labels in the browser.

\texttt{Paw++matrix.fontList: *-courier-medium-r-normal*-120-*}

Font used for the Ntuple/Scan matrix (accessible via the \texttt{Ntuple Viewer}).

\texttt{Paw++helpFont: *-courier-bold-r-normal*-120-*}

Font used for help windows.

\texttt{Paw++fontList: *-swiss*742-bold-r-normal*-120-*}

Font for the menus, messages and boxes.

\texttt{Paw++keyboardFocusPolicy: pointer}

If “explicit” focus is determined by a mouse or keyboard command. If “pointer” (default), focus is determined by the mouse pointer position.

\texttt{Paw++doubleClickInterval: 400}

The time span (in milliseconds) within which two button clicks must occur to be considered a double click rather than two single clicks.

\texttt{Paw++dirlist*background:}

Specify the background color for the iconbox part of the browser.

\texttt{Paw++dirlist*object*iconForeground:}

Specify the foreground color for the icons of type \texttt{object}.

\texttt{Paw++dirlist*object*iconBackground:}

Specify the background color for the icons of type \texttt{object}.

\texttt{Paw++dirlist*object*iconLabelForeground: black}

Specify the foreground color for the labels of the icons of type \texttt{object}.

\texttt{Paw++dirlist*object*iconLabelBackgroundColor: white}

Specify the background color for the labels of the icons of type \texttt{object}. Currently the following different \texttt{object}’s are defined:
Appendix A. X Window resources

- dir -- directory
- 1d -- 1d histograms
- 2d -- 2d histograms
- ntuple -- Ntuples
- pict -- Higz pictures
- chain -- Ntuple chains
- entry -- Ntuple chain entries
- hbook -- Hbook files

The default iconForeground and iconBackground colors for these objects are:

- Paw++/dirlist/dir/iconForeground: blue
- Paw++/dirlist/1d/iconForeground: DarkGoldenrod3
- Paw++/dirlist/2d/iconForeground: DeepPink3
- Paw++/dirlist/ntuple/ntuple/iconForeground: SteelBlue3
- Paw++/dirlist/pict/iconForeground: green4
- Paw++/dirlist/chain/chain/iconForeground: blue
- Paw++/dirlist/entry/entry/iconForeground: OrangeRed

When using a black and white X Server use the following resource settings to make the icons visible:

- Paw++/dirlist/<object>/iconForeground: black
- Paw++/dirlist/<object>/iconBackground: white
- Paw++/dirlist/<object>/iconLabelBackground: black
- Paw++/dirlist/<object>/iconLabelForeground: white

A.2 X resources for KUIP/Motif

This is a list of the X resources available to any KUIP/Motif based application (e.g. PAW++). Resources control the appearance and behavior of an application.

Users can specify their own values for these resources in the standard X11/Motif way (via the .Xdefaults file or a file in the /usr/lib/X11/app-defaults directory). One just has to prefix the desired resource by the class name of the application.

To customize PAW++, for instance, all the resources have to be prefixed with Paw++ or they should be stored in the file /usr/lib/X11/app-defaults/Paw++.

Any default values specified by KUIP are given behind the resource name.

*background:

Specify the background color for all windows.

*foreground:

Specify the foreground color for all windows.

*kxtermGeometry: 550x550+5+10
A.2. \textit{X resources for KUIP/Motif}

Geometry of Kxterm, the KUIP terminal emulator (Executive Window).

\begin{verbatim}
*kuipGraphics_shell.geometry: 550x550+585+10
\end{verbatim}

Geometry of the graphics window(s) (if any).

\begin{verbatim}
*kuipBrowser_shell.geometry: 580x450
\end{verbatim}

Geometry of the browser(s).

\begin{verbatim}
*XmText*fontList: *-helvetica-bold-r-normal*-120-*
*XmTextField*fontList: *-helvetica-bold-r-normal*-120-*
\end{verbatim}

Font used by all text areas.

\begin{verbatim}
*kxtermFont:
\end{verbatim}

Font used by Kxterm (PAW++ Executive Window)

\begin{verbatim}
*dirlist*fontList:
\end{verbatim}

Font used for the icon labels in the browser.

\begin{verbatim}
*helpFont: *-courier-bold-r-normal*-120-*
\end{verbatim}

Font used for help windows.

\begin{verbatim}
*fontList: *-helvetica-bold-r-normal*-120-*
\end{verbatim}

Font for the menus, messages and boxes.

\begin{verbatim}
*keyboardFocusPolicy: explicit
\end{verbatim}

If “explicit” (default), focus is determined by a mouse or keyboard command. If “pointer” focus is determined by the mouse pointer position.

\begin{verbatim}
*doubleClickInterval: 250
\end{verbatim}

The time span (in milliseconds) within which two button clicks must occur to be considered a double click rather than two single clicks.

\begin{verbatim}
*dirlist*background:
\end{verbatim}

Specify the background color for the iconbox part of the browser.

\begin{verbatim}
*dirlist*:object*:iconForeground: black
\end{verbatim}

Specify the foreground color for the icons of type \texttt{object}.
Appendix A. X Window resources

*dirlist*<object>*iconBackground: white

Specify the background color for the icons of type *object*.

*dirlist*<object>*iconLabelForeground: black

Specify the foreground color for the labels of the icons of type *object*.

*dirlist*<object>*iconLabelBackgroundColor: white

Specify the background color for the labels of the icons of type *object*.

*zoomEffect: True

Turn zoom effect on or off when going up and down directories in the browser.

*zoomSpeed: 10

Specify speed of zoom effect in the browser.

Currently the following different *object*s are defined:

-  
  Cmd    -- Command
  InvCmd -- Deactivated command
  Menu   -- Menu tree
  MacFile -- Macro File
  RwFile -- Read-write file
  RoFile -- Readonly file
  NoFile -- No access file
  ExFile -- Executable file
  DirFile -- Directory
  DirUpFile -- Up directory (..)

When using a black and white X Server use the following resource settings to make the icons visible:

*dirlist*<object>*iconForeground: black
*dirlist*<object>*iconBackgroundColor: white
*dirlist*<object>*iconLabelBackgroundColor: black
*dirlist*<object>*iconLabelForeground: white
Appendix B: Editing keys in the Input Pad

"C-b" means holding down the Control key and pressing the b key. "M-" stands for the Meta key and "A-" for the Alt key.

C-b:    backward character
A-b:    backward word
M-b:    backward word
Shift A-b:    backward word, extend selection
Shift M-b:    backward word, extend selection
A-[:    backward paragraph
M-[:    backward paragraph
Shift A-[:    backward paragraph, extend selection
Shift M-[:    backward paragraph, extend selection
A-<:    beginning of file
M-<:    beginning of file
C-a:    beginning of line
Shift C-a:    beginning of line, extend selection
C-osfInsert: copy to clipboard
Shift osfDelete: cut to clipboard
Shift osfInsert: paste from clipboard
Alt->:    end of file
M->:    end of file
C-e:    end of line
Shift C-e:    end of line, extend selection
C-f:    forward character
A-]:    forward paragraph
M-]:    forward paragraph
Shift A-]:    forward paragraph, extend selection
Shift M-]:    forward paragraph, extend selection
C-A-f:    forward word
C-M-f:    forward word
C-d:    kill next character
A-BS:    kill previous word
M-BS:    kill previous word
C-w:    kill region
C-y:    yank back last thing killed
C-k:    kill to end of line
C-u:    kill line
A-DEL:    kill to start of line
M-DEL:    kill to start of line
C-o:    newline and backup
C-j:    newline and indent
C-n:    get next command, in hold mode: next line
C-osfLeft:    page left
C-osfRight:    page right
Appendix B. Editing keys in the Input Pad

C-p: get previous command, in hold mode: previous line
C-g: process cancel
C-l: redraw display
C-osfDown: next page
C-osfUp: previous page
C-SPC: set mark here
C-c: send kill signal to application
C-h: toggle hold button of pad containing input focus
F8: re-execute last executed command
Shift F8: put last executed command in input pad
Shift-TAB: change input focus
Appendix C: The Motif user interface tools

C.1 Scale

A scale can be moved with the scale button, or with the two arrows (top and bottom). It is usually linked to some quantity which may vary continuously.
C.2 Buttons

Various kind of buttons are available in Motif: Toggle, Push and Selection buttons.

C.2.1 Toggle Buttons

The toggle buttons are usually used for Yes/No choices. In a serie of toggle button, only one can be push.

C.2.2 Push Buttons

Push buttons are usaly used to perform a specific action. Very often they open an other panel.
C.2.3 Selection Buttons

Selection buttons are used to select an option or a special mode. They are not linked together like the toggle buttons and they can be independently from the state of the others.

C.3 Paned Window

Paned window separate a window in several part. Each part is resizeable but the global size stay the same: when a part grow an other one reduce.

C.4 Window manager buttons

This tools a present on all the Motif windows.

A double click on this button closes the window. a simple click display a pull down menu. The content of the this menu depends on the window manager used.

These two buttons allows respectively to iconise and to enlarge a window to the maximum size possible on the screen.
Index

CERNLIB, 1
Cut Editor, 3, 75, 76

Executive Window, 1, 2, 5, 7, 13, 78, 79, 82

Graphics Window, 1–3, 38–43, 45

HBOOK, 9, 24, 30, 34, 37, 38
HIGZ, 1
Histogram Style Panel, 1, 2, 9–11, 40, 49, 50, 72, 73
HPLOT, 57

Input Pad, 1, 2, 4–6, 84

KUIP, 4, 7, 78, 79, 81, 82

Main Browser, 1, 5, 7, 9, 22, 24, 26, 28–30, 49
Motif, 1, 7, 78, 79, 81, 87

Ntuple Viewer, 1, 3, 12, 75, 79, 80

PAW (Physics Analysis Workstation), 1, 4, 12, 13, 17, 28, 51–53, 57, 78
PAW++, 1–3, 9, 38, 79, 81, 82
PAW++ Locate, 3, 45, 47, 48
PostScript, 18

RZ, 21, 22

Transcript Pad, 1, 2, 4, 5, 13

X11, 1, 6, 78, 79, 81

ZEBRA, 19–22, 33